
Software Update Notification for DTS 
v4.10.doc 

May 2005 Page 1 of 14 pages

 

 
Filename: Software Update Notification for DTS v4.10.doc Doct. Version No: 1
Date: May 2005 Author: M.T.Connah
 

 
 

Product PartNo.-Issue 
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Product PartNo./Version 

Zetasizer Nano series PSW0085/4.10 
Firmware PFW0044/1.31 

 
Manuals PartNo./Version 

Zetasizer Nano series MAN0317/2.20 
MPT-2 MAN0318/2.10 
HPPS MAN0314/2.00 

 
Software update summary 

 
 

Main features 
Addition of selection of units for a number of parameters, e.g. Radius/diameter 
Addition of a statistics bar to the records view. 
The method for adjusting the pH during a pH titration has been simplified and the time 
required reduced 
A single button implementation of a fast mode for the correlator settings has been added to 
the research software 
Addition of ability to do CMC titrations 
Addition of facility to monitor sample count rate without starting measurement 
Addition of a new analysis type to the research software - Discrete Exponential Analysis 
All parameters are now displayed to a defined format 
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1. Overview 
This document is the software release note for Zetasizer Nano series software P/N PSW0085 
on software suite PSS0012-10 in accordance with DCO4113 
 
1.1 Main feature comments 
 

1.1.1 Unit selection 
It is now possible to select the units for a number of parameters. The data in a record is 
stored in a pre-defined format that cannot be altered. The units that are actually displayed are 
defined by the user workspace. This means that a particular record can be displayed in 
different formats depending on the workspace settings of the particular user displaying the 
data. 
 
The units are linked in all places that they are displayed. This means that the units will always 
be consistent in a particular workspace setting. 
The heading in the record view now consists of two lines, the top line being the parameter 
name, and the second being the parameter unit. Where there is an option to change a unit, 
left or right clicking on the unit will give a selection of the units available. Clicking on a unit will 
change the unit name on the second bar, and also change the numerical value of the unit 
displayed in all the records being viewed. 
Simultaneously, all references to this parameter will change in the reports selected, and in the 
SOP settings. 
The parameter units can also be changed within a report by right clicking on a unit, or in an 
SOP page, and similarly this will change all occurrences of the display of the parameter. 
These unit settings will be stored with the workspace. 
 

1.1.2 Statistics bar 
A statistics bar has been added to the bottom of the record view. This can display a maximum 
of four parameters, mean, standard deviation and maximum and minimum values. Selection 
of the bars to view is either by right clicking on any displayed bar, then selecting ‘Statistics bar 
and the parameter required, or by selecting the ‘statistics bar’ option from the ‘View’ menu. 
The bar will display a value for all numerical parameters for the records selected. Records are 
selected in the normal Windows fashion using click and drag, or combinations with the shift 
and control keys. 
The record numbers for the records selected are displayed in the top bar that is displayed. A 
range of records is displayed separated by a bar, e.g. 1-7, and non-contiguous records are 
separates by commas. A combination of these methods is also used, e.g. 1-7,15, 23 
 

1.1.3 Titration algorithm 
A new method is implemented for pH autotitrations. This new method will shorten the time 
taken for a titration without having to use a pre-scan. It takes sample buffering into account 
and is designed to avoid overshooting the target pH. Back titration is not allowed, and this 
avoids any tendency to ‘hunt’ for the correct pH value, which could previously add to the 
measurement duration. 
The success of the titration, i.e. reaching each of the target pH values in a reasonable time, 
without overshooting still relies on a well calibrated pH probe in good condition. 
The ability to measure a buffer correctly, and stabilise in a short time is not a good enough 
test as this does not duplicate the performance of the probe in a real sample. 
After calibration, a better test is to measure the pH of a known concentration of a strong acid 
or base. For example a 1 millimolar solution of Hydrochloric acid should be pH 3. In such a 
test the pH measured should be within 0.1pH units of the expected value. 
Note that SOP’s originally set up in version 4.00 that used a pre-scan, will still enable the pre-
scan method to be used, however SOP’s created using 4.10 will not allow this method. There 
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is an option to retain the pre-scan method if required, please contact Malvern Instruments UK 
for details. 
 

1.1.4 Fast correlator mode 
The method of implementing the fast mode of the correlator available in the research 
software, has been simplified. There is now a single radio button to enable or disable the fast 
mode. It is disabled as default, as this is the default setting in the standard software. 
Enabling the fast mode adds 16 channels of 25ns each, starting at 25ns. As the response 
time of the detector does not allow pulses to be generated at intervals of less than 50 ns the 
first channel displayed is at 75 ns. In addition, the logarithmic correlator, which as default has 
the first channel at a delay time of 0.5 microseconds, will start at 0.25 microseconds. 
Note that if the fast mode is implemented, even though the analysis may use the same delay 
times as the default settings, there can be subtle differences in the result due to the different 
integration times used by channels with the same time value. 
 

1.1.5 CMC titrations and poor data 
Whenever multiple measurements are done, it is now possible for the measurement to 
continue even though the data collected cannot be analysed. 
In the case of a titration, error suppression is automatic. In this case, an error message with a 
timer will be displayed. If a user does not interrupt the measurement, the correlation function 
will be stored, and the measurement will continue at the end of the timed period. 
This is useful in the case of a concentration titration, for example, to determine the critical 
micelle concentration (CMC). Below the concentration that micelles appear, the data may be 
too poor to analyse, but the intensity information could still be useful, and the data is likely to 
improve at higher sample concentrations. 
In the case of a temperature trend measurement, or a time trend measurement done by 
specifying a number of repeat measurements, the error message can be suppressed by 
selecting, ‘allow results to be saved containing correlation data only’.  

1.1.6 Sample count rate monitor 
A count rate meter is available that shows a continuous display of the sample count rate 
without having to start a measurement. The option is available under the ‘Tools’ menu. A 
dialog box displays the count rate and gives the user has access to the attenuator settings 
and the cell type used. 
Selecting the cell type displays the default measurement position for that cell. The user can 
accept this by selecting the ‘set’ button. 
In a similar manner, the user can change the attenuator setting by selecting the attenuator 
required, then selecting the ‘set’ button to change the attenuator to that setting. 
If a measurement is started, this dialog box will close and the Tools menu item will be greyed 
out. 
 

1.1.7 Discrete Exponential Analysis 
This is an addition to the research software, designed particularly for protein samples. 
This analysis allows the user to input information known about the sample to give more 
precise information about the proportion of up to three components in the sample. 
There are two method of inputting information. The sizes of expected components can be 
chosen, or alternatively the number of multimers of the second and third peak can be 
specified. 
The result gives the size and proportion of the two or three peaks detected. No peak width is 
calculated as it is assumed in this special case that each peak consists of a single size 
component. 
More advice is available in the sizes tab after the Discrete Exponential analysis has been 
chosen. 
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1.1.8 Parameter format 
All displayed parameters now have a defined format. The parameter will be defined either as 
text, with properties such as the maximum length allowed, or numeric, with a definition of the 
format such as exact display, e.g. correlator channel contents, or a defined number of 
decimal points, e.g. 1 for the temperature. 
For simplicity all parameters are assigned to categories which then have the same format 
properties. ‘Size’ is one class of format and in this case, the display is to 3 significant figures. 
This format to a number of significant figures has not been available before, examples in the 
case of the size class are; 0.678nm, 1.23nm, 12.3nm, 123nm, 1230nm. 

2. Compatibility 
2.1 Optics unit 
 
Version 4.10 software is compatible with all hardware variants of the Zetasizer Nano series 
and the HPPS. 
 
 
2.2 Data 
Version 4.10 will read data from all versions from 3.xx and 4.00. It will not read data from 
Version 1.00 or V1.10 software. If data taken with a previous version is edited, even if only 
the sample name is changed, the result can change due to small changes designed to 
improve the analysis.  
 
2.3 Computer 

2.3.1 Operating system 
Version 4.10 is only compatible with Windows 2000 Pro (Sp4 or later) and Windows XP Pro 
(Sp1a or later) 
Windows XP Pro is the preferred option as the complete alpha test has been performed on 
this operating system. 
 
NOTE: Windows NT and Windows XP ‘Home’ version are not supported 
 

2.3.2 Minimum Computer Requirements 
Pentium PC 233MHz, 128MByte RAM, 20MByte free hard disk space, 1024 x 768 screen 
resolution, CD-ROM drive, 1 free USB port, Windows 2000 Pro (SP4 or higher) or Windows 
XP Pro (SP1a or later) operating system. 
Use with the HPPS requires one free PCI slot 
 
The software and system can be used with a laptop computer with a free USB port. 
Use of a laptop with the HPPS requires a free type 2 PCMCIA slot and a special PCMCIA 
card. Please contact Malvern Helpdesk for details. 
The PC must meet the minimum requirements of the operating system software. 

2.3.3 Recommended Computer Requirements 
Pentium P4 PC 2.6GHz, 512MByte RAM, 40GByte hard disk drive, 1024 x 768 screen 
resolution, CD-ROM drive, USB port, Windows XP Pro (SP1a or later) operating system. 
 
The software and system can be used with a laptop computer with a free USB port. 
Use of a laptop with the HPPS requires a free type 2 PCMCIA slot and a special PCMCIA 
card. Please contact Malvern Helpdesk for details. 
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3. Functional Features, changes since version 3.32 
 

3.1 Additions 

SCR Description 

2553 Addition of facility to monitor sample count rate without starting measurement 
2940 Option to reset temperature to ambient after temperature trend measurement 
4232 Option to append measurement number to sample name after zeta potential 

and size trend SOPs. 
4292 Correlogram will now be saved even if data cannot be analysed 
4234 The measurement can be initiated immediately by selecting the start icon. The 

measurement will then start after temperature equilibration is complete. 
4352 The trend table properties can be configured from the main application as well 

as from the from the report designer. 
4365 An option is added to reset the temperature to a defined value at end of a 

temperature scan 
4372 Addition of a new analysis type to the research software - Discrete Exponential 

Analysis 
4391 Addition of ability to edit many results simultaneously 
4410 Addition of titration tutorial for the MPT-2 
4460 Addition of pH read back during an additive titration 
4466 Addition of % over/under plots to the zeta potential statistics graph  
4479 Addition of ability to do CMC titrations 
4484 Audible indication on completion of SOP 
4606 Addition of normalised diffusion output from White-Mangelsdorf calculation 
4658 Addition of reference beam count rate, measured voltage and measured 

current parameters to recorded data 
4665 Addition of second virial coefficient error and correlation coefficient parameters 
4671 Addition of selection of units for parameters 
4673 Addition of a statistics bar to the records view. 
2869 Reference beam count rate should be available as parameter in zeta 

measurement records. 
 
 
3.2 Deletions 
None 
 
3.3 Changes 

SCR Description 

4440 The method for adjusting the pH during a pH titration has been simplified and 
the time required reduced 

4489 The Integration method for the White-Mangelsdorf calculation has improved 
accuracy 

4508 Sub-runs can be saved for zeta potential measurements in the research 
software 

4631 The reports have been changed to take alteration of parameters and display of 
units into account 

4648 A single button implementation of a fast mode for the correlator settings has 
been added to the research software 

4652 Parent and child records are now always shown even if one of the record types 
doesn't match the workspace settings. 

4672 All parameters are now displayed in a new defined format 
4709 The stirrer in the MPT2 is now activated when the "pH Monitor" tab is accessed 
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4730 MPT2 tutorials have been updated. 
4779 Molecular weight: Count rates for the scattering standard and the solvent are 

now displayed before the operator is prompted to accept them. 
4760 MPT2 pre-measurement clean and prime message prompt has been updated. 
 

 
 
3.4 Bug Fixes 

 

SCR Description 

4178 The tab key now sets the focus to material or dispersant properties tabs on the 
sample page. 

4490 The selection of cutoff/number of points in research software (Edit Result) is 
corrected 

4547 The create average result feature error when averaging zeta results generated 
using the monomodal analysis type is corrected 

4557 Titration measurements would fail under Windows XP unless running with 
Administrator privileges. 

4603 The cell position is reported correctly as 2.00mm for zeta measurements taken 
on a 90 degree size measurement system. 

4641 The default size analysis settings have been corrected 
4647 The number of analysis points are now correctly set 
4651 Errors in the cumulants analysis for the HPPS have been corrected 
4653 The Alpha value is now stored correctly  
4655 The cumulants settings for the OQ SOPs supplied have been corrected 
4657 The size limits displayed are now correct in the OQ SOPs 
4660 The correlator page has an interim fix for the parameter settings 
4662 Errors in coated sphere model have been corrected 
4677 Problems with Runge Kutta solver in White Mangelsdorf calculation have been 

corrected 
4684 The parameter dictionary text name for the distribution analysis threshold 

(lower and upper) are now correct 
4710 Checking the "Enable Stirrer" box in the "Clean" and "Fill" tabs now activates 

the stirrer 
4734 Removed molecular weight measurement type from SOP editor for 90° 

instruments. 
4743 Molecular weight fit error is now reported correctly. 
4772 Derived mean count rate, i.e. without the reference beam, is now stored 

correctly during zeta measurements. 
4781 Temperature is no longer set to 25°C when measurement window is closed. 
 
 
 
 
3.5 Known Issues and comments 

3.5.1 USB Detection 
USB detection occurs automatically on new computers. On older computers the instrument is 
not always detected automatically and the instrument icon in the bottom right-hand corner of 
the status bar will remain greyed-out. This is fixed by closing the application, restarting the 
computer and restarting the software. 
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3.5.2 Missing parameters in user reports 
The parameter dictionary has been updated for this version of the software and some of the 
parameters have changed. For reports that the user may have created containing the affected 
parameters, the parameters will become undefined. This can be seen when a report is 
opened and the parameter displays the text ‘No parameter has been selected’ or nothing is 
shown next to the text label (i.e. the value appears blank). To fix this problem for each 
parameter carry out the following steps:- 

1) Double-click on the affected parameter to bring up its property dialogue. 
2) Click the ‘Select’ button to display the ‘Select a parameter’ dialogue. 
3) Select the relevant parameter. 

N.B. Remember to correct the affected parameters on both the screen and page layout views 
of the report. 
 

3.5.3 Results 
 
The analysis algorithms for the calculation of size, zeta potential and molecular weight, 
including data filtering, are being continually improved. The effect of this is that if data taken 
from a previous version of software is edited, the result may change, even if only the sample 
name is edited. 
This is because the algorithms themselves are not stored with the record. 
This does not apply to parameters stored with the record such as the viscosity, and refractive 
index etc. as the same parameters are always used in the recalculation of the edited result. 
 
This does not of course change the result in the stored record, as after editing a new record is 
created. To tell if a record is the original or has been edited, the parameter ‘Is edited’ can be 
added to a report or the record view. This can be found in the measurement audit information 
section of the parameters list. It will display ‘False’ if the record has not been edited. 
 

3.5.4 Manual measurement settings 
Installing version 4.10 software will cause the manual measurements settings to revert to their 
default values. After installation any changes are preserved between settings. 
 

3.5.5 Application error when editing the analysis limits of existing zeta measurement 
records 
Editing the zeta potential range of an existing record may cause an error, and the software 
will have to be shut down. This editing is mostly required when measuring samples in low 
dielectric constant media, or when using very low voltages. 
 
A suitable range should be set before the measurement. For a sample in a dispersant with a 
very low dielectric constant such as hexane, the zeta potential range in the results calculation 
page, under the advanced button should be set to -500mV to 500mV 
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3.5.6 Latest firmware required when running SOPs created with version 4.10 software 
This is a problem for existing users if an SOP is created with version 4.10 software without 
having the instrument connected on start-up (so the firmware is not updated). If the 
instrument is then connected (without restarting the application) and an attempt made to run 
the SOP then it will fail with the error message shown below:- 
 

 
The fix for this problem is to restart the application with the instrument connected. 

3.5.7 The following SCRs detail issues that currently exist within the software. 
 

SCR Description 

2364 Export Data dialog does not remember the last destination filename and path 
that was used. 

2650 Unexpected filling using the Filled Graph option 
2653 Can set the warning and action limits wrong way round 
2657 Melting point SOP dialogs should display a warning with fixed temperature 

dispersant 
2735 Dragging records onto desktop fails 
2746 Tables have insufficient numerical precision 
2855 Clicking on a measurement or report file from the "Start->Documents" toolbar 

fails to open 
2881 It should not be possible to delete a security group if there are users in it. 
2882 Deleting a group should be audited 
2883 It is currently possible to add a user without specifying any group. 
3005 Melting Point - automatic run duration may not be suitable choice 
3066 Graphs - The statistics graph does not correctly support the Weight 

transformation 
3130 No warning message when running a zeta, molecular weight or melting point 

SOP on a HPPS. 
3131 User reports will not print unless they are added to the current workspace. 
3151 Zooming in on a graph does not refresh the tick labels. 
3186 21 CFR - Can create a group with the same name as an existing group. 
3411 Dielectric constant value should change with temperature. 
3491 If the software can not access the registry it gives a run-time error 
3714 Record browsing in print preview does not work 
4067 User ->New User menu does not force values in password and password 

confirmation boxes. 
4123 Not possible to change the name of a Workspace 
4143 Protein Utilities: Pasting a graph into Wordpad changes the graticle line style 
4169 Audit trail does not record the copying of records 
4237 Research Software:Edit Result, no explanation on coated sphere 
4286 Number of runs still tries to limit the measurement to 6 hours, instead of 

allowing 10,800 
4345 Record appears selected when it isn't 
4405 Add ability to use own larger beaker 
4407 Allow increment and points option in dilution titration 
4414 Zeta edit result not possible for monomodal measurement data 
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SCR Description 

4427 Problems with default printer can cause the application to crash 
4446 Printing the record view exhibits different behaviour than printing a report 
4488 Cannot batch print to pdf 
4539 Size measurement optimisation routine should follow temp equilibration 
4553 Add temperature coefficients 
4610 Current Record selection is deselected if a new report is added 
4616 Cannot view a read-only audit trail file. 
4617 Software freezes when attempting to open a none audit trail file in the audit trail 

viewer 
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4. Installation 
4.1 Installation Procedure for Windows 2000 Pro 
You must uninstall the previous version before installing the new version. See the 
‘Uninstall procedure’ below. 
 
The software suite comes on an auto-loading CD-ROM. Inserting the drive into a system 
configured to Auto-run a CD will run the installation program automatically. If your system 
does not support this feature run the \setup.exe program from the root directory of your CD 
drive. 

4.1.1 Record view headings 
The new record view unit headings will not be displayed unless the existing workspaces are 
deleted. The current headings are stored in a file automatically named as the user currently 
logged on to the computer with a ‘.wrkspace extension’. e.g. JOHN SMITH.wrkspace 
To access the new headings this file must be deleted or renamed after the uninstallation 
procedure. 
After uninstalling the software navigate to the ‘C:\Program Files\Malvern Instruments\DTS’ 
directory. This will contain the user workspace. This can either be deleted, in which case a 
new user workspace will automatically be created during the installation process, or it can be 
renamed to allow its use later. Note only the ‘.wrkspace’ extension can be used. During the 
installation a new workspace will automatically be created, and the new record headings will 
then be displayed. 
 

4.1.2 Example data 
The examples data file has been updated.  
To access the new examples file the old file must be deleted or renamed after the 
uninstallation procedure and before the new software version is installed. 
After uninstalling the software navigate to the ‘C:\Program Files\Malvern 
Instruments\DTS\Measurement Data’ directory. This will contain the example results.dts file. 
This can either be deleted, or it can be renamed to allow its use later. Note the ‘.dts’ 
extension must be used to enable access to a file from within the application. During the 
installation the new example results will be installed. 
The example data is most conveniently viewed in the summary workspace as all the reports 
to view the data are available in this workspace. 
 
Note: If the system has a previous version of 3.xx or 4.xx installed, then this must be 
uninstalled before version 4.10 is installed as it cannot be co-resident. Version 1.10 (HPPS) 
can be left on the system and version 4.10 installed 
Note: On the instrument selection screen, the type of instrument, laser wavelength and 
scattering angle must be specified. Text information is supplied on this screen to help with 
your selections. 
Note: For DTS Series software, Windows 2000  Pro and Windows XP  Pro will not allow 
an installation if the user does not have administrator access. This is in line with Microsoft’s 
Logo policy and is standard practice. 
Note: Windows 2000 Pro systems require service pack 4 or later in order to install the 
software. 
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4.2 Installation Procedure for Windows XP Pro 
Windows XP may give the following warning during the installation. This warning can safely 
be ignored by clicking ‘Continue anyway’ as the software installation has been tested on 
Windows XP. 

 
4.3 USB Driver Installation  
Note: Driver installation on Windows 2000  Pro and Windows XP  Pro will fail if the user 
does not have administrator access. This is in line with Microsoft’s Logo policy and is 
standard practice. 
 

4.3.1 Windows 2000 
With the software installed the instrument should be connected via the USB port. The drivers 
should now be installed automatically without any user input. 
 

4.3.2 Windows XP Pro 
With the software installed the instrument should be connected via the USB port. This will 
result in the found new hardware dialogue appearing: 
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This should be left with the default selection of ‘Install the software automatically’ and the 
‘Next’ button should be pressed so that file transfer begins. During file transfer a similar 
warning dialogue as appeared in section 6.2 may be displayed. Once again the ‘Continue 
Anyway’ button should be pressed so that file transfer completes. Once file transfer has 
completed the ‘Finish’ button should be pressed to complete the installation.    
 
4.4 Uninstall Procedure 
The software can be uninstalled using the standard Add/Remove feature in the Windows 
‘Control panel’ 
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5. Customer deliverables 
5.1 Application Software Suite 
The software is contained on one CD-ROM. The disk is labelled PSS0012/10 

The installed software requires about 80Mbytes of hard disk space. 

5.1.1 Disk contents 
•  Operating software including update help files for all new features plus tutorials 

 
•  Zetasizer Nano series operators guide, Issue 2.20 

•  MPT-2 Operators guide, version 2.10 

•  HPPS Operators guide, Version 2.0 (Covers up to version 3.00 software. Later 
features are covered in the help files) 

•  Firmware version 1.31 

•  USB drivers for the Zetasizer Nano 

•  Hardware drivers for the HPPS, for both desktop and laptop operation 

•  Software Update Notifications for all versions of software from version 3.00 to present 

•  Adobe Acrobat reader 


